CHAPTER 4

Spatial data management
In the previous chapter you have seen how spatial data is entered in ILWIS via
digitizing. Another method for obtaining spatial data is the conversion of digital
data in other file formats. These data are often not directly usable in an analysis.
The data may still need to be edited. The data may be in the wrong data type for a
specific type of analysis. You may have to convert data from one vector type to
another (e.g. from segments to polygons), or from vector to raster (rasterization).
The data may also contain the wrong coordinates, georeference, domain or
representation.
In this chapter the various spatial data management operations are shown, which
precede the actual data analysis. The first part of this chapter (section 4.1) deals
with the import of raster and vector maps from different file formats. Special
attention is paid to the import of ILWIS 1.4 data. In section 4.2 the topic of map
projections is treated, and how you can change maps from one projection to
another. In section 4.3 tools for vector data management are shown, and in section
4.4 the vector to raster conversion is demonstrated. Then in section 4.5 the tools for
the management of raster maps are explained.
The final section 4.7 focuses on the conversion of domains.
Before you can start with the exercises, you should start up ILWIS and change to
the subdirectory c:\ilwis21\data\usrguide\chap04, where the data files for this
chapter are stored.
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•

Double-click the ILWIS program icon in the ILWIS program group.

•

Change the working drive and the working directory until you are in
the directory c:\ilwis21\data\usrguide\chap04.
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4.1 Importing digital data
In the previous chapter you have seen how to digitize maps. Maps may already be
available in digital format, from another source. They may have been generated
using different software, they may have resulted from scanning maps, or they may
be available as digital satellite images or scanned images. In order to use these
digital data in ILWIS, importing the files and changing them to the ILWIS file
formats is required. Importing can be done with the Import module, in which you
can select the import format. Importing many files from ILWIS 1.3, 1.4 or 1.41 can
also be done using the Batch Import from ILWIS 1.4 operation.
Before you import files into ILWIS, you should know what type of data you are
going to import. Whether it is a point, segment, polygon or raster map, and what
type of information is stored inside the map. The content of a map determines the
domain type (class, ID, value, image, picture, color etc.) that will be assigned to the
imported map.
Importing raster maps
Raster maps can be imported from a number of file formats. Some of these formats
do not allow for the storage of coordinates. This is the case for the frequently used
file interchange formats: Tag Image File Format (TIF), and the Windows
Bitmap format (BMP). When you import a raster map from these formats, the
resulting ILWIS map will have a Georeference None. This means that the map is
not georeferenced.
The TIF file format is frequently used as the storage type for scanned images. Here
an example of importing a scanned aerial photograph of the city of Cochabamba is
shown as example.

F

•

From the File menu of the main window, select Import. The Import
dialog box is opened.

•

Select the import format: Tag Image File Format .TIF.

•

Select the file: Airphoto.tif. Leave the Output File name as it
is and click OK. The map Airphoto is now imported.

•

Open the raster map Airphoto and check that it doesn’t have
coordinates.

•

From the Edit menu of the map window, select Properties, and 1
map Airphoto. The Properties dialog box is opened. Check the size
of the map. Check the domain.

•

Close the dialog box and the map window.

As you can see the import of black and white TIFF images, results in an image
domain for the output map.
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When you import a TIFF image, the domain of the imported image depends on the
storage type of the TIFF file. ILWIS can import raster data with 1 bit/pixel (into
domain bit), 4 or 8 bits/pixel (into domain image), 4 or 8 bits/pixel with a color
lookup table (into domain picture), up to 24 bits per pixel (RGB, into domain
color). The same is true for files that are in Windows bitmap format (.BMP).
The user has no control over the selection of output domains of these maps.
Methods to convert domains of maps are explained in exercise 4.6.
Now some examples of importing Windows bitmap files will be shown: One of a
map showing the country of Bolivia (Bolmask). The other map is a hillshading
image of Bolivia and its surroundings (Sashad) with 8 bits/pixel, with a color
lookup table, resulting in an ILWIS map with a picture domain.

F

•

From the File menu of the main window, select Import. The Import
dialog box is opened.

•

Select the import format: Windows bitmap .BMP.

•

Select the file: Bolmask.bmp. Leave the Output File name as it is
and click OK. The map Bolmask is now imported.

•

Import also the Windows bitmap Sashad. Open the raster maps
Bolmasks and Sashad. Check the domain types and other
properties of both maps. Close the map windows. The maps will be
used later on.

Other file formats, such as the ERDAS .GIS, ERDAS .LAN and IDRISI .IMG, also
allow for the conversion of coordinate information. The conversion of these file
formats will result in maps with a georeference corners.
Here an example is shown of the import of an ERDAS .LAN file (Orthoim.lan),
containing a digital orthophoto of the Cochabamba study area, made with the
orthorectification module that will be included in the next ILWIS version.

F

ILWIS User’s Guide

•

From the File menu of the main window, select Import. The Import
dialog box is opened.

•

Select the import format: Erdas .GIS .LAN.

•

Import the file: Orthoim.lan. As you can see after importing a
raster map and a georeference are created, all with the same name
(Orthoim).

•

Open the Properties dialog box of the georeference Orthoim. Click
the Edit Properties button and change the coordinate system to
Cochabam.
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•

Display raster map Orthoim and add the vector maps Contour
and Drainage, so that it is clear that the map has the correct
coordinates.

•

Close the map window.

If you have a raster image in a file format that is not in the list of import file
formats in ILWIS, you may try to import it with the option General Raster
Format. In order to do that you need to have detailed information on your raster
map, such as the length of the header, the number of bands in the file, the number
of columns, the storage type (bit, integer, floating point) etc.
Importing vector data
The most frequently used file formats for importing vector data in ILWIS, are the
Arc/Info .E00 format and the AutoCad .DXF format.
The conversion from Arc/Info .E00 format depends on the contents of the file, and
will either result in a segment map, possibly with a point map containing polygon
labels, or a polygon map. The domain will always be identifier.
The conversion from AutoCad .DXF may be a segment map, a polygon map and/or
a point map, depending on the contents of the file. If the codes in the .DXF file only
contain numerical values (as is the case for contour lines), the output domain will
be value. Otherwise it will be a class domain (if there is more than 1 code).
In this example a map of South America, in AutoCad .DXF format (Samerica),
will be imported as a polygon map with a class domain. Note that in this case each
polygon has a separate boundary line, without topology.

F
From the File menu of the main window, select Import. The Import
dialog box is opened.
•

Select the import format: AutoCad .DXF.
Select the file: Samerica.dxf. Leave the Output map name as it
is and click OK. The map Samerica is now imported.

•

Open the Properties dialog box of the polygon map Samerica, and
change the coordinate system to Latlon. The coordinates in this
map are geographical coordinates.

•

Display the polygon map Samerica, and check the names of the
polygons, and the coordinates.

•

Close the map window.

For more information on the import of vector and raster data, see the On-Line
Help or the Reference Guide.
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Importing from ILWIS 1.41 or earlier
Data from ILWIS 1.3, 1.4 or 1.41 can be imported into ILWIS 2 for Windows.
Depending on the type of ILWIS 1.4 data, and the file extension, a certain output
domain will be suggested by the program.
When you import raster maps from ILWIS 1.4 you should select the following
output domains:
−

Domain Class when the elements in the original map are named by class
names (e.g. mapping units in thematic maps). The .MPD, .MPI, .COL and
.INF files should be available for domain Class raster maps.

−

Domain ID when the elements in the original map are uniquely named (e.g.
cadastral plots). The .MPD, .MPI, and .INF files should be available for
domain ID raster maps.

−

Domain Value when the elements in the original map refer to measurable
values (e.g. altitude). The .MPD and .MPI files should be available for domain
Value raster maps.
You will see the effect of the available file extensions on the suggested output
domain, using four maps (all representing the land use in the Cochabamba area) in
ILWIS 1.41 format. The first map (Map1) has .MPD, .MPI, .COL, and .INF files.
The second map (Map2) only has .MPD, .MPI and .COL files. The third map
(Map3) only has .MPD and .MPI files.
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•

From the File menu of the main window, select Import. The Import
dialog box is opened.

•

Select the import format: ILWIS 1.4 raster map .MPD.

•

Select the file: Map1.mpd. Click OK. The Input raster map from
ILWIS 1.4 dialog box is opened. The suggested output domain is
class, since class names are found in the .INF table.

•

Click OK. Raster map Map1 is now imported.

•

Open the Import dialog box again, select the same import format,
and select raster map Map2. Click OK. The suggested output domain
is now Picture, since no .INF is found. Click OK.

•

Open the Import dialog box again, select the same import format,
and select raster map Map3. Click OK. The suggested output domain
is now Image, since no .INF, or .COL is found. Click OK.

•

Display the three maps (Map1, Map2 and Map3). Open the pixel
information window, and compare the contents of the three maps.

•

Close the map windows and the pixel information window when
finished.

The following rules apply when you want to import other data:
ILWIS User’s Guide
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−

Importing satellite images: The .MPD and .MPI files of the satellite bands
should be available. Any .COL files must be deleted, otherwise the suggested
domain will be picture. During Import 1.4, select domain Image for satellite
imagery with values ranging from 0-255. When the image is stored in ILWIS
1.4 as an integer map, you should select the domain NOAA when the image
contains NOAA data, ranging from 0-1023, or the domain radar when the
image contains radar data (JERS, ERS, Radarsat), ranging from 0-32767.
Scanned raster data can be imported when the .MPD, .MPI are available. If the
scanned data consists of gray values, select domain Image during Import 1.4. If
the scanned data is in color, the .COL should also be available. Select domain
Picture during Import 1.4.

−

Importing color composites: The .MPD, .MPI, and .COL files of the color
composite should be available. You may need to save the color composite’s
color look up table (.COL) in ILWIS 1.4; give it the same name as the color
composite. During Import 1.4, select domain Picture for color composites.

−

To import bit maps, the .MPD and .MPI files should be available. There is no
need for a .COL file. Bit maps are automatically imported with domain Bit.

−

To import integer maps, the .MPD and .MPI files should be available.
Normally an integer map in ILWIS 1.4 represents values. In that case there is
no .INF file, and the ILWIS 2 file will get the domain value. If the integer map
represent classes or ID’s an .INF file should also be available. In that case you
can select as ILWIS 2 domain either class (which is unlikely, since you would
normally not have more than 256 classes in a map) or ID domain.

−

When importing polygon maps that were rasterized, the .SEG, .CRD, .TOP
and .POL files should be available. All these files should have the same name.

−

When importing segment maps, the .SEG and .CRD files should be available.
In ILWIS 2.1, polygonized segment maps are only imported as polygon maps.

−

When importing point maps: The .PNT should be available.

Summary: Importing data
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−

Raster maps can be imported from a number of file formats. Some of these
formats do not allow for the storage of coordinates. This is the case for the
frequently used file interchange formats: Tag Image File Format (TIF), and
the Windows Bitmap format (BMP). Other file formats, such as the ERDAS
.GIS, ERDAS .LAN and IDRISI .IMG, also allow for the conversion of
coordinate information.

−

The most frequently used file formats for importing vector data in ILWIS are
the Arc/Info .E00 format and the AutoCad .DXF format.

−

Data from ILWIS 1.3, 1.4 or 1.41 can be imported into ILWIS 2.1 for
Windows. Depending on the type of ILWIS 1.4 data and the file extension, a
certain output domain will be suggested by the program.
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4.2 Map projections
The maps that you obtain after importing, often need to be changed before you can
use them in combination with the rest of your data. The different tools that you can
use to change vector and raster maps will be explained in the rest of this chapter.
One of the most important changes that may have to be done is related to the
coordinates of the map. The map may not have coordinates (in the case of raster
maps imported from TIFF or BMP for example). In that case you will have to
georeference and resample so that they have equal dimensions, pixel size and
projection as the other maps. Also, for vector maps which have coordinates by
definition, these coordinates may not be the ones that you use for other maps. In
that case you will need to transform the coordinate system. The most important
reason that coordinate may be different (apart from the fact that a local coordinate
system may have been used), is that the original maps had different projections.
A map projection defines the relationship between the map coordinates and the
geographic coordinates, latitude and longitude.
The Geographic Coordinate system is a spherical coordinate system composed of
parallels of latitude (phi) and meridians of longitude (lambda) (see figure 4.1.a).

Figure 4.1: A: Geographic coordinate system: The location of A is determined by the longitude (λ)
and the latitude (φ). B: The relationship between a sphere with radius a and an ellipse
with major and semi-axis a and b

Because of the earth’s rotation, the shape of the earth is not a perfect sphere. The
earth is flattened towards the poles: The equatorial axis (line from the center to the
equator) is longer than the polar axis. The earth’s shape can be represented by an
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ellipsoid, or as it is sometimes called, a spheroid (shapes that are generated by
revolving an ellipse around its minor axis).
A spheroid has 2 different semi-axes a and b, where a is the radius of the equator
circle and b is the half axis of rotation ( b < a). See figure 4.1b.
The flattening of the ellipsoid is defined by:
f = (a-b)/a,
and the eccentricity:
e*e = (a*a - b*b) / a*a
It follows that the ellipsoid shape is also completely defined by a and f or by a
and e. Nearly 93% of the earth’s land surface is mapped using only four of these
ellipsoids: International, Krassovsky, Bessel and Clarke (1880). Table 4.1 lists the
ellipsoids available in ILWIS. They are stored in text file Ellips.def. In this file,
for each ellipse the value of a (equatorial radius) and 1/f (the inverse of the flattening)
are listed. If no ellipsoid is known, the choice by default is a sphere with a = b =
6356007 m.
The choice of the ellipsoid, which fits best a given region of the earth’s surface to
be mapped, depends on the surface curvature and geoid undulations in that region.
Hence every country has its own “best” ellipsoid.
Table 4.1: Some reference ellipsoids which can be chosen in ILWIS
International 1924
Sphere
Australian National
Modified Airy
GRS 1980

Krassovsky 1940
Airy 1830
WGS 72
Modified Fischer 1960
S.American 1969

Bessel 1841 (2x)
Helmert 1906
WGS 84
Hough 1960
Clarke (1866)

Clarke 1880
International (Hayford)
Everest (5x)
Indonesian 1924

The surface of the earth is curved but this should be presented in maps as a plain
surface. This will always result in some deformation or distortion, unless you use a
spheroidal map (a globe). To correctly represent the curved earth’s surface on a flat
map, you need a special map projection. With the help of a map projection,
geographic coordinates are converted into a two dimensional metric coordinate
system, measuring the X and Y directions in meters. Each map projection has
unique equations for the transformation from geographic to metric coordinates.
Map projections can be subdivided according to three aspects: Class, aspect and
properties.
There are three classes of map projections:
−

Cylindrical projections
Cylindrical projections may be imagined, as the transformation to a
plane that is wrapped around the globe in the form of a cylinder (see
figure 4.2). Note that it is possible that the cylinder intersects the sphere
(a secant cylinder). The outline of the world map would be rectangular
in shape.
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−

Azimuthal projections
These projections may be imagined as the transformation on a plane
tangent to the globe (figure 4.2). As with the cylindrical projections,
here the plane may intersect the sphere ( a secant plane). The
characteristic outline of the world map would be circular.

−

Conical projections
These projections may be imagined as the transformation to a plane that
is wrapped like a cone around the globe (figure 4.2). The possibility of a
secant cone is also present in this class. The outline of the world would
be fan shaped.

Figure 4.2: Cylindrical, azimuthal and conical projections. For each projection a tangent (touching
the globe), and a secant (intersecting the globe) version is shown. The lower right part
of the figure illustrates two aspects: Normal (oriented parallel to the earth’s axis) and
transversal (oriented perpendicular to the earth’s axis)

Projections can also be subdivided according to their aspect: The direction in which
a cylinder, plane or cone is oriented with respect to the globe. In figure 4.2 two
possibilities are given: Normal and transverse aspects. For cylindrical projections a
normal aspect is a cylinder that touches the equator. A transverse aspect is a
cylinder that touches the poles. Similarly the normal and transverse aspects of
azimuthal projections can be visualized. The aspect may also be oblique; in that
case the cylinder, plane or cone is not horizontally or vertically oriented, but
something in between.
Another important way to subdivide map projections is according to their
properties. As mentioned before, a map projection always results in some
ILWIS User’s Guide
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deformation or distortion. Depending on the type of projection, these distortions
will be different. This is indicated by the so-called special properties. The most
important properties are:
−

Conformality: A conformal map is one in which all angles are indicated
correctly. All angles measured on the earth’s surface are measured with the
same values in the map. As all angles are maintained, the shape of the objects
is also preserved.

−

Equivalence: A map with an equivalence property is called an equal-area
map. Although the shape of objects is distorted, the area as measured on the
globe is correctly indicated on the map.

−

Equidistance: An equidistant map has the characteristic that in one direction
the distances are preserved.
Map projections are named according to the class, the aspect, the property, the
name of the originator and the nature of any modification. In table 4.2 an overview
is given of the projections available in ILWIS.
Let us look at some map projections and see how the map of the world is displayed.

F

•

Open the segment map World.

•

From the Edit menu in the map window, select Annotation. The
Annotation Editor is opened. The use of the Annotation Editor will
be explained in detail in chapter 13. Here we only need to add a
graticule.

•

The Display Options- Graticule
Click the Graticule button.
dialog box is opened. Click OK. The graticule is now added to the
map window, showing parallels and meridians every 20 degrees.

•

Click the Exit Editor button.

Now the effect of several map projections on the display of the world map will be
demonstrated. For each projection a new coordinate system should be created.

F
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•

Drag the map window to the side of the screen.

•

In the main window open the File menu and select Create and
Create Coordinate system.
The Create Coordsystem dialog box is opened.

•

Type for the Coordinate system name: Centcyl.

•

Type for the description: Using the central cylinder
projection.
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Click OK. The Coordinate System Editor is opened.
•

Click the Projection button.

•

Select the projection: Central Cylindrical. Click OK.

The Coordinate System editor now displays more information, relevant for this
projection. The Central Cylindrical uses the equatorial radius of the earth, since the
cylinder touches the earth at the equator. See figure 4.2.
The false easting, false northing and central meridian are used to define the X, Y
coordinates of the map. False easting: Overall increase of map x-coordinates
(‘eastings’), indicating the eastward shift of the origin of the projection relative to
the redefined origin (negative if projection origin is west of false origin).False
northing: Overall increase of map y-coordinates (‘northings’), indicating the
northward shift of the origin of the projection relative to the redefined origin
(negative if projection origin is south of false origin). We won’t change them now.

F

•

Type some positive values for Max X,Y. These coordinates will be
adapted anyway, based on the map displayed in the map window.

•

Click OK in the Coordinate Sytem Editor.

•

Drag and drop coordinate system Centcyl to the map window in
which the map World is displayed.

•

Note how the World map and the 20 degrees graticules change.

•

Zoom in on the central part of the world, around the equator.

The map you see is not conformal nor equal area. It is projected perspectively from
the center of the earth onto a cylinder tangent to the equator (see figure 4.2). The
equator and other parallels are straight lines (spacing increases towards the poles)
and meet meridians (equally spaced straight lines) at right angles. Parallel spacing
increases towards the poles than Equator. The poles cannot be shown. Scale is true
along the equator. Shape, area and scale distortion increase rapidly away from the
equator. This map projection only shows the areas surrounding the equator
correctly. All other areas are too much distorted.

F
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Create another coordinate system: Lamazea. Select the projection:
Lambert Azimuthal Equilarea.

•

Type some positive numbers for Max X Y. These coordinates will be
adapted anyway, based on the map displayed in the map window.

•

Enter for the Sphere Radius: 6356007.

•

Click OK. Drag and drop coordinate system Lamazea to the map
window displaying the map World.
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Table 4.2: Some of the projections used in ILWIS
Projection
Cylindrical
Central cylindrical
Equidistant
cylindrical
EquiRectangular
Mercator
Trasverse Mercator

UTM
Lambert Cylindrical
Equal Area
Miller Cylindrical
Mollweide
Azimuthal
Lambert Azimuthal
Equal Area
Hammer Aitoff
Azimuthal Equidistant

Orthographic
Stereographic

Gnomonic
Conical
Albers Equal Area
Conic
Lambert Conformal
Conical
Equidistant Conic
Polyconic
Other projections
Sinusoidal

Van der Grinten
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Remarks
Map is perspective but not conformal nor equal area. Projected perspectively from the center of the earth
onto a cylinder tangent to the equator. Only used for teaching purposes.
Also called Simple Cylindrical or Plate Carree. Used for raster maps which store information of the whole
world: Each pixel represents a square block of LatLon coordinates, i.e. information is stored per degree, per
minute, etc. Used for mapping the earth taken as a sphere.
Also called Plate Rectangle. Variant of Plate Carree. Used for raster maps which store information of the
whole world: Each pixel represents a rectangular block of LatLong coordinates.
Conformal. Designed for navigational use; standard for marine charts. Recommended use for conformal
mapping of regions predominantly bordering the equator. Often inappropriately used as a world map.
Also called Gauss Conformal, or Gauss Krüger. Transverse form of the Mercator Projection (conformal). Used
for many topographic maps at scales from 1: 20000 to 1: 250000. Recommended for mapping regions that
are predominantly north-south in extent.
Universal Transverse Mercator. Map is conformal. Widely used for topographic maps and military maps.
Lambert Cylindrical Equal Area. Mainly used for educational purposes.
Compromise between Mercator and other cylindrical projections. Used in numerous world maps.
Pseudo-cylindrical projection. Map is equal area. Occasionally used in thematic world maps.
Lambert Azimuthal Equal Area. Used for maps of continents and hemispheres. Also suited for regions
extending equally in all directions from a center point, such as Asia and the Pacific Ocean.
Hammer Aitoff Equal Area, variant of Lambert Azimuthal Equal Area.
Azimuthal Equidistant. Commonly used in the polar aspect for maps of polar regions and the Northern and
Southern hemispheres. The oblique aspect is frequently used for world maps centered on important cities
and occasionally for maps of continents.
Known by Egyptians and Greeks 2000 years ago. Map is perspective and neither conformal nor equal area.
Only one hemisphere can be shown. The earth appears as it would on a photograph from space.
Apparently invented by Hipparchus (2nd century BC). Used in combination with UTM projection as Universal
Polar Stereographic (UPS) for mapping poles and in navigation charts for latitudes above 80°.
Recommended for conformal mapping of regions that are approximately circular in shape. For example,
used for topographic maps of the Netherlands.
Map is perspective and neither conformal nor equal area. It is used to show great circle paths as straight
lines and thus to assist navigators and aviators.
If the pole is one of the standard parallels, it is equal to Lambert's Equal Area Conic. Frequently used for maps of
the United States, for thematic maps and for world atlases. Recommended for equal area maps of regions
that are mainly east-west in extent.
Lambert Conformal Conic/Conical Orthomorphic (Lambert, 1972) (conformal). Extensively used for large-scale
mapping of regions predominantly east-west in extent. Further widely used for topographic maps.
Also called Simple Conic. The most common projection in atlases for small countries.
or American Polyconic (Hassler, ± 1820). Map is neither conformal nor equal area.
The sole projection used for large scale mapping of the United States by the USGS until the 1950's.
used since 16th century. Also called Mercator Equal Area. Pseudo-cylindrical projection. Map is equal area.
Used in atlas maps of South America and Africa. Occasionally used for world maps. Modifications are
called sinusoidal interrupted and sinusoidal 3x interrupted.
Shows the entire earth within one circle. All areas, shapes and angles are greatly distorted
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You will see that the world is projected in a circular way on a plane which touches
the earth at 0 degrees latitude and longitude. Therefore, the equator and the 0
degrees meridian are straight lines.

F

•

Open coordinate system: Lamazea.

•

Enter for the Central Meridian: 60 00 00 W (this is in degrees,
minutes, seconds).

•

Enter for the Central Parallel: 20 00 00 N.

•

Click OK. Press the redraw button in the map window.

Now the projection is such that the plane touches South America. The equator is no
longer a straight line. Only the 60 degrees W meridian is now a straight line.
Now the effect of a conical projection will be demonstrated.

F

•

Create another coordinate system: Laconco. Select the projection:
Lambert Conformal Conical.

•

Type some positive numbers for Max X Y.

•

Enter for the Sphere Radius: 6356007.

•

Click OK. Drag and drop coordinate system Laconco to the map
window displaying the map World.

Now only the area surrounding the North pole is displayed, in a very distorted way.

F

•

Open coordinate system: Laconco.

•

Enter for the Central Meridian: 20 00 00 W.

•

Enter for the Central Parallel: 50 00 00 S.

•

Enter for the Standard Parallel 1: 40 00 00 S.

•

Enter for the Standard Parallel 2: 60 00 00 S.

•

Click OK.

•

Press the redraw button in the map window.

The southern hemisphere is now shown in a conical projection.
Some projections will also be shown that are useful for displaying world maps.
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F

•

Create another coordinate system: Ortho. Select the projection:
Orthographic.

•

Type some positive numbers for Max X Y.

•

Enter for the Sphere Radius: 6356007.

•

Click OK.

•

Drag and drop coordinate system Laconco to the map window
displaying the map World.

The world map is now displayed as if you look at the earth from space.

F

•

Open coordinate system: Ortho.

•

Enter for the Central Meridian: 90 00 00 E.

•

Enter for the Central Parallel: 30 00 00 N.

•

Click OK.

•

Press the redraw button in the map window.

You will now see the continent of Asia.

F

•

See the effect of the Plate Carree projection.

•

See the effect of the Mercator projection.

•

See the effect of the Mollweide projection.

•

See the effect of the Sinusoidal projection.

•

Try other projections also, if you like.

•

When finished, close the map window.

Up to now you have only seen the different projections displayed on the screen. To
actually transform the map, you need to use the Transform Segment operation in
this case, since the map world is a segment map. For points you use the Transform
Points, and for polygons, the Transform polygons operation. They work basically
the same.

F
Click segment map World with the right mouse button and select
vector operations, Transform Segments. The Transform Segment
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Map dialog box is opened.
•

Select the Coordinate System: Lamazea.

•

Type for Output Segment map: Wlamazea.

•

Click on Show and OK.
The segment map Wlamazea is created. The Display options
dialog box is opened.

•

Click OK. The map is displayed.

•

Add a graticule to the map window and look at the effect.

•

Close the map window when you are finished.

The UTM projection
There is one map projection that will be treated in more detail, since that is the
most used projection used in GIS and image processing, for relatively small study
areas. The Universal Transverse Mercator projection system was developed in the
late 1940s by the US Army. Since then, it has become standard in topographic
mapping. The UTM comprises the following features:
−

The projection is the “Gauss- Krüger” version of the Transverse Mercator.

−

The projection is only intended for mapping between 84° N and 80° S. Beyond
that there is too much distortion.

−

The unit of measure is the meter.

−

The world is divided into 60 zones of 6° of longitude in width. Zone 1 has its
western edge at the 180° meridian. Zone 60 has its eastern edge on the same
meridian. Consequently the zones are numbered from west to east. The zones
are shown in figure 4.3. Cochabamba is located 66° 08’ 52” W in longitude,
and 17° 23’ 30” S in latitude. So it is located on the boundary between UTM
zones 19 and 20.

−

A second zoning is made along the latitudes following 8° intervals (except for
the most northern zone that has an interval of 12°). These zones have a better
designation from south to north (see figure 4.3). So Cochabamba is located in
zone 19K.

−

The origin of each zone is located on a point at the equator, where it is
intersected by the central meridian of that zone.

−

The Easting of the origin of each zone is assigned a value 500,000 m.

−

Each zone has its own coordinate system.
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Figure 4.3: UTM grid zone designations for the world, shown on an equidistant cylindrical projection
index map

−

The UTM has a special convention for recording the Northings. For the
southern hemisphere the equator is assigned the value 10,000,000. For the
northern hemisphere the value at the equator is assigned as 0.

−

The UTM might use one of the following definitions of the shape of the earth:
International Spheroid, Clarke 1866 (Africa), Clarke 1880 (North America),
Everest or Bessel (both for smaller parts of Southern and South East Asia).
One of the objections to the introduction of the UTM map projection, was the
method of dividing the world into 60 zones. A country was likely to be divided into
several UTM zones, each having its own coordinate definition and origin. Still the
UTM system was accepted worldwide. Many maps show the coordinates of the
national system as well as those of the UTM.
For large scale mapping, if an area lies within more than one UTM zone, the entire
area has to be mapped as if it lies in that zone. One should select the zone that
occupies the major part of the area, extending the borders of the zone over the +3°
and -3° boundaries.
Likewise, if the country covers both sides of the equator, the coordinates from the
southern hemisphere are extended for the part on the northern hemisphere (so
larger than 10,000,000).
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The data on the projection used should be found on the topographic map, from
which you have digitized the information. On the topomap of Cochabamba, the
following information is given:
−

Ellipsoid: International.

−

Projection: Transverse Mercator.

−

Vertical Datum: Sea level.

−

Horizontal datum: Provisional South America 1956.

−

UTM zone: 19 K.

F

•

Open the coordinate system: Cochabam.

•

Click the Ellipsoid button and select the Ellipsoid: International
1924.

•

Click the Datum button and select the Datum: Provisional South
America 1956 and select the Area: Bolivia.

•

Click OK.

•

Clear the check box Northern Hemisphere.

•

Enter for the (UTM) Zone: 19.

•

Click OK in the Edit Coordinate System dialog box.

Now suppose you want to convert data from the Cochabamba area from UTM zone
20 to UTM zone 19. In order to do that you need to make a new coordinate system,
in which the UTM zone 20 is indicated.

F
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•

Create a new coordinate system: Cocha20.

•

Enter some positive values for Max X and Y.

•

Click the Projection button and select the Projection: UTM.

•

Click the Ellipsoid button and select the Ellipsoid: International
1924.

•

Click the Datum button and select the Datum: Provisional South
America 1956 and select the Area: Bolivia.

•

Click OK.

•

Clear the check box Northern Hemisphere.

•

Enter for the UTM zone: 20.

•

Click OK in the Edit Coordinate System dialog box.
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Now that a new coordinate system is made for UTM zone 20, you can link this
coordinate system to the maps digitized in that projection.
Checking coordinate transformation
Before making a coordinate transformation, it is wise to check the transformation
for a few coordinate pairs. This can be done with the Transform Coordinates
dialog box.
The following steps have to be done:
−

Select a certain point on one of the paper maps and note its X and Y
coordinates.

−

Determine this point on the other paper map and note its X and Y coordinates.

−

Enter one of the coordinate pairs in the ILWIS Transform Coordinates dialog
box as the following:

F

•

Double-click TransfCrd icon in the Operation-list.

The Transform Coordinate dialog box is opened. The options in this box can be
used to check whether the transformation is correct. It allows you to select an input
and output coordinate system, to type the X and Y coordinates of a point to be
transformed and to interactively view the output coordinates for the selected point.

Figure 4.4: The corner of the topomap of sheet “Cochabamba” indicated the grid in UTM 19
coordinates, the tickmarks in UTM 20 coordinates and the upper left corner in
Geographic coordinates
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First you will check whether the conversion from latitude/longitude to metric
coordinates of a certain UTM zone is correct.

F

•

Select the coordinate system Latlon.

•

Type the latitude and longitude as indicated in the corner of the map
in figure 4.4.

•

Select the coordinate system Cochabam in the list box Output
Coordinate System.

•

Check the metric coordinates of UTM zone 19 with those in the map
in figure 4.4. Write them down.

•

Select the coordinate system Cocha20 list box Output Coordinate
System.

•

Check the metric coordinates of UTM zone 20 with those in the map
in figure 4.4. Write them down.

Now you will check if the conversion of coordinates from UTM zone 20 to 19 is
done correctly.

F

•

In the Transform Coordinates dialog box select the input
coordinate system Cocha20.

•

Type the X and Y values that have been noted down for the
conversion from Latlon to UTM 20.

•

Select the coordinate system Cochabam in the list box Output
Coordinate System.

•

Check the metric coordinates of UTM zone 19 with those that you
have written down for UTM 19.

•

Close the Transform coordinates dialog box.

The calculated coordinates for this point in other projections will be displayed in
the box. You should check the X and Y value with the ones you have noted from
the paper map with the UTM projection. Small differences may occur, due to
rounding errors. If the calculated coordinates are very different, you better check
whether the projection parameters in the input coordinate system are correct. If the
calculated coordinates are the same, follow the next steps to transform the actual
map.
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Transforming vectors
After checking that the transformation of some known points in two maps with
different projections is done correctly, you can do the actual transformation. In this
example, we have a map City20, in which the outline of the city of Cochabamba
is digitized in UTM 20 coordinates. This polygon file will be transformed to UTM
zone 19. There is also a segment map City19, with which you can check the
result.

F

•

Display polygon map City20. This map has coordinates in UTM
20.

•

Display segment map City19. This map has coordinates in UTM
19.

•

Try to drag-and-drop polygon map City20 on the map window
displaying City19. An error message will appear, since the two
maps have different coordinate systems, and different UTM zones.

Now the actual transformation can be done.

F

•

Close both map windows.

•

Double-click TransfPol in the Operation-list.

The Transform Polygon Map dialog box is opened.

F
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•

Select the map City20 in the list box Polygon Map.

•

Select Cochabam in the list box Coordinate System.

•

Type City19 in the text box Output Polygon Map.

•

Select the check box Show.

•

Click OK. The Display Options - Segment Map dialog box is
opened.

•

Accept the defaults by clicking the OK button. Polygon map City19
is displayed.

•

Check the result by adding segment map City19 to the map
window.

•

Zoom in where the lines are doubled.
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•

Add gridlines every 1000 meters (in blue), and a graticule (in green)
every 5 minutes.

•

Close the map window when you have finished the exercise.

Summary: Map projections
−

After importing vector maps, their coordinates may not be the ones that you
use for your other maps. In that case you will need to transform the coordinate
system. The most important reason that coordinate may be different (apart
from the fact that a local coordinate system may have been used) is that the
original maps had different projections.

−

A map projection defines the relationship between the map coordinates and the
geographic coordinates latitude and longitude.

−

Projections are classified according to their class (cylindrical, azimuthal,
conical), their aspect (normal, transverse) and their properties (conformality,
equivalence, equidistance).

−

The Universal Transverse Mercator projection system, is the most used
projection used in GIS and image processing, for relative small study areas.
The world is divided into 60 zones of 6° of longitude in width.

−

Before making a coordinate transformation, it is wise to check the
transformation for a few coordinate pairs. This can be done with the
Transform Coordinates dialog box.

−

After checking that the transformation of some known points in two maps with
different projections is done correctly, you can do the actual transformation.
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4.3 Vector data management
A vector map can be obtained either via digitizing a paper map, as was explained in
chapter 3, or from importing digital vector data, as was shown in exercise 4.1. A
number of tools are available to adapt vector maps for the analysis. In order to be
able to use vector maps of the same area together, all maps should have the same
coordinate system. In the previous section the transformation from one coordinate
system to another was explained. In this section a number of tools for further
manipulating vector maps will be shown, such as the creation of a sub map,
combining two or more vector maps into one map, copying selected information
from a vector map using a mask, densifying coordinates, or thinning them using
tunneling, editing vector maps, and the conversion from one type to another. The
change of the domain type of the map will be explained in exercise 4.6.
Creating a sub map
The sub map operation makes it possible to select a certain window in a vector map
and save it as a new map. This can be helpful if you want to use only a part of a
larger map for your analysis. In this exercise, a selected window of the segment
map Drainage will be saved as a new segment map.

F
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•

Double-click SubSeg in the Operation - list.
The Sub Map of Segment Map dialog box is opened.

•

Select segment map Drainage in the list box Segment Map.

•

Type 797200 for minimum X and 8078200 for minimum Y in the
text box Min X, Y.

•

Type 805300 for maximum X and 8083300 for maximum Y in the
text box Max X, Y.

•

Type Drainsub in the Output Segment Map text box.

•

Click the Check box Show.

•

Click OK.
After calculating the map the Display Options - Segment Map
dialog box is opened.
Click OK.
The map is displayed.

•

Compare it with the map Drainage.

•

Close the map window when you have finished the exercise.
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Glue two segment maps
This operation merges two or more segment maps of the same coordinate system
and domain together. By default, it copies all segments of the input maps into the
output map, unless a mask to select specific segment codes is specified. The
operation also, by default, creates coordinate boundaries for the output map, based
on the minimum and maximum X and Y coordinates of the input maps when it is
not defined by the user. Note: If the user-defined coordinate boundaries are smaller,
all segments of the input maps that fall within these coordinates are copied, and the
segments outside this boundary are deleted.

!

The output map of this operation may have double segments which can be
removed by editing the map (see chapter 3 on how to edit segments).
The segments that are supposed to continue in two or more sheets are not
automatically connected to each other in the output map. They can be
connected in the Segment Editor using the Move points option.

Suppose you have digitized contour lines for the Cochabamba area from two map
sheets. Now you want to combine them into one single map. Suppose also that you
only want the hundred meter contour lines. This means you have to use a mask.

F

•

Display segment map Connorth. This segment map contains the
contour lines for the northern part of the study area.

•

Also display Consouth. This map contains the segments for the
southern part of the area.

•

Close both map windows.

•

Double-click the item GlueSeg in the Operation-list.
The Glue Segment Map dialog box is opened.

•

Select the option 2 for Number of Input Maps.

•

Select the map Connorth and Consouth in the list boxes Map.

•

Type ??00 in both text boxes Mask. This has the effect that only the
contour lines with 100 meter contour interval are copied.

•

Type Concomb in the text box Output Segment Map.

•

Click the check box Clip boundary.

This check box is used when a user wants to specify different coordinate boundaries
for the output map than those of the combination of the input maps. Otherwise, by
default, the output map comprises the whole area of all input maps.
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F

•

Type for Min Y: 8071798. Type for Max Y: 8090600. Select the
check box Show.

•

Type the Description: 100 meter contour lines in the
entire study area.

•

Click OK.
The Display Options - Segment Map dialog box is opened. Accept
the defaults by clicking the OK button in this dialog box. The new
segment Concomb is displayed.

•

Close the map window when have finished the exercise.

Masking vector data
This operation allows to selectively copy points, segments, or polygons into a vector
map, by specifying a mask which lists the codes that are to be copied. A mask
contains one or more codes, separated by a comma (spaces before or after a comma
make no difference). Asterisks can be used as a wild card for zero or more
characters (e.g. grass*,forest* or 1*, 2*). Also question marks may be
used to replace only one character (e.g. the mask ??00 in a contour map, returns all
contour lines with two numbers, followed by two zeros). For more information,
open the Help, search for Mask, and open the Help topic: How to use masks. See
also chapter 7, in which more examples of data retrieval with a mask will be given.
Any vector map (with domain type class, ID, value) can be used as input map in
this operation. In fact there are three separate operations for points (MaskPnt),
segments (MaskSeg) and polygons (MaskPol), but they work the same. The
output map uses the same domain, coordinate system and coordinate boundaries as
the input polygon map. In this example, the map City19 will be used to extract
only the grid lines.

F
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•

Display the segment map City19, and open the domain to look at
the domain items. Close the domain editor and the map window.

•

Double-click the MaskSeg item in the Operations-list.
The Mask segments dialog box is opened.

•

Select segment map City19 in the list box Segment Map.

•

Type Grid19 in the text box Mask.

•

Type Grid19 in the text box Output Segment Map.

•

Click the check box Show.

•

Click OK.

•

The Display Options - Segment Map dialog box is opened.
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•

Accept the defaults by clicking the OK button in this dialog box. Now
only the grid lines are shown.

•

Close the map window when you have finished the exercise.

Densify segment coordinates
The operation DensSeg adds extra intermediate coordinates within segments of an
input map, at a user-specified distance, and copies them to an output segment map.
It is advised to use this operation before the Transform segments operation is
performed. The segment map Grid19, which was created in the previous exercise,
will be used as an example. This map contains gridlines, digitized for the
Cochabamba area. Each gridline in the input map is defined by a starting and
ending coordinate.

F

•

Double-click DensSeg in the Operation-list.
The Densify Segment Coordinates dialog box is opened.

•

Select the map Grid19 in the list box Segment Map.

•

Type 200 in the text box Distance. An intermediate coordinate will
be added every 200 meters.

•

Type Grid19n in the text box Output Segment Map.

•

Click the check box Show.

•

Accept the defaults by clicking the OK button.
The Display Options - Segment Map dialog box is opened.

•

Accept the defaults by clicking the OK button in this dialog box.
The map is now displayed. Apparently there is no difference.

•

Close the map window.

In order to be able to compare the output segment map (Grid19n) with the input
map (Grid19), you need to look at both maps in the Segment Editor, which
allows you to see the intermediate coordinates as crosses. The editor can only be
used on maps that are not dependent, so the dependency link should be broken first,
for both maps.

F
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•

Break the dependencies of the maps Grid19 and Grid19n (by
selecting the Break Dependency Link in the properties dialog box).

•

Click the map Grid19 with the right mouse button and select Edit
from the Context-sensitive menu.
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•

Click OK in the Display Options dialog box. The Segment Editor
is opened.

•

Select the Move point mode and zoom in on a part of the map. As
you can see each gridline only has a starting and ending point. Close
the Segment Editor.

•

Click the map Grid19n with the right mouse button and select Edit
from the Context-sensitive menu. The Segment Editor is opened.

•

Zoom in on a part of the map and select the Move point mode. As
you can see there are now intermediate coordinates at regularly
spaced intervals of 200 meter. Close the Segment Editor.

•

Close the map windows when you have finished the exercise.

Tunnel segments
This is more or less the opposite of the densify coordinate operations. The aim of
this operation, is to reduce the number of intermediate points and remove
superfluous nodes within segments of the input map. This operation can also be
used when you want to generalize your maps. The principle of tunneling was
explained in chapter 3.

F

•

Double-click TunnelSeg in the Operation-list. The Tunnel
Segments dialog box is opened.

•

Select the map Drainage in the list box Segment Map.

•

Type 20 (meter) in the text box Tunnel Width.

•

Type Drtun20 in the text box Output Segment Map. Click on the
check box Show. Click OK. The Display Options - Segment Map
dialog box is opened. Accept the defaults by clicking the OK button
in this dialog box.

•

Repeat the exercise twice: Once with a tunnel width of 50 meters
(result map Drtun50), and the other with a tunnel width of 100
meters (result map Drtun100).

•

Compare the results by displaying the maps Drtun20, Drtun50
and Drtun100 in the same map window, and zooming in on a part
of the map.

•

Close the map windows when you have finished the exercise.

Creating a polygon map from a segment map
In some cases you may have a segment map from which you want to generate a
polygon map. This may be the case if you have imported a polygon map from
130

ILWIS User’s Guide

Spatial data management
Arc/Info E00 format. The import results in a segment map and a point map,
containing polygon labels.
When you want to generate a polygon map from a segment map, there are two
possibilities:
−

Using the Segment Editor. This method should be followed when you are not
sure whether the segment map is error free. In the segment editor you can edit
the segments, make a check of them, and then polygonize them. This method
was explained in exercise 3.5.

−

Using the SegPol (Polygonize Segment Map) operation. This method can be
followed when you are sure that the segment map is correct. The advantage of
this method is that it can be used in an automated way to periodically update
files.
The last method will be shown.
In this example a segment map (Landuni2) will be used, similar to the map used
in exercise 3.5, but without errors. To create a polygon map out of a segment map,
all segments in the input map should be correctly digitized, that means no dead ends, no
intersections, no double segments, etc. The output of this operation is a polygon map
with an internal domain which contains class names or IDs such as pol1, pol2, pol3,...,
etc. The domain type (class or ID) of the output polygon map is defined by the user.

F

•

Double-click SegPol in the Operation-list. The Polygonize
Segment Map dialog box is opened.

•

Select segment map Landuni2 in the list box Segment Map.

•

Type Landuni3 in the text box Output Polygon Map.

•

Click the check box Show.

•

Clear the Label Point box.

•

Click OK. After creating the polygon map, the Display Options Polygon Map dialog box is opened. Click OK.

•

Check the meaning of the polygons by clicking them.

•

Close the map window when you have finished the exercise.

The resulting polygon map has an internal domain, indicating the different
polygons as Pol1, Pol2 etc. You should still open the polygon map as a domain
and change the names, or create an attribute table to reclassify them. A better
option would be to polygonize the map using label points. The label points can be
generated from another polygon map using the PolPnt operation, or digitized as a
point map. In this case a label point map was already made (point map
Landunit).
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F

•

Open polygon map Landuni3.

•

Drag-and-drop point map Landunit in the map window. The
Display Options dialog box is opened.

•

Select the check box Text and click OK. The points are displayed on
top of the polygons.

•

Close the map window.

•

Click polygon map Landuni3 with the right mouse button and
select Vector Operations and Assign Labels. The Assign Labels
to Polygons dialog box is opened.

•

Select the Label Points: Landunit, and type for Output Polygon
Map: Landunit. Click the check box Show and click OK.

•

Click OK in the Display Options dialog box. The polygon map
Landunit now contains the correct names. Close the map window.

Creating a segment map from a polygon map
The extract boundaries operation creates a new segment map out of a polygon map,
containing all polygon boundaries. The input map for this operation is a polygon
map with any domain type. The output map resulting from the conversion is a
segment map with an internal class domain. The class name of a segment in the
output map, is the combination of the name of the neighboring polygons. For
example, the boundary between two polygons with the class name Lake and
Mountain is codified in the output segment map as Lake|City.
In this exercise the polygon map Landuse is converted to a segment map.

F
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•

Display polygon map Landuse, and click several polygons to find
out their names. Close the map window.

•

Double-click PolSeg in the Operation-list. The Boundaries of
Polygons dialog box is opened. Select the polygon map Landuse in
the list box Polygon Map. Type Luse in the text box Output
Segment Map.

•

Clear the check box Single Name. If this check box is selected all
segments get the name: Segments.

•

Click the check box Show. Click OK. After creating the segment
map the Display Options - Segment Map dialog box is opened.

•

Select the check box Info. Click OK. Click several segments to find
out the meaning of the codes.
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•

Close the map window when you have finished the exercise.

Several other conversion options between point, segment and polygon maps are
possible. They are described in the Reference Guide and the On-line Help.
Summary: Vector data management
The following tools can be used to manage vector data:
−

Creating a submap of a vector map and merging two or more vector maps.

−

Selectively copying vector data using a mask.

−

Obtain more intermediate coordinates within segments in a segment map.

−

Tunneling: reduces the amount of coordinate data stored in a segment map.

−

Creating a polygon map from a segment map, either using the segment editor
or the SegPol operation.
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4.4 Vector to Raster conversion
As has been mentioned already in chapter 1, most of the analyses in ILWIS are
based on raster data. Therefore, conversion from vector to raster format
(rasterization) is often a necessary step preceding the analysis. Points, segments and
polygons are represented by grid cells (pixels) in the raster data structure. In order
to convert a map from vector into raster format, a mesh with pre-defined cell size,
is laid over the map. The size of the grid cells is a crucial aspect of the raster data
structure.
Before starting the rasterization, a georeference should be created. A georeference
contains the minimum and maximum X and Y coordinates of the raster map, the
number of rows and columns and the pixel size. When rasterizing various maps of
the same area, it is preferred to select the same Georeference for them.
The resulting raster maps have the same domain as the corresponding source vector
map. Since the vector to raster operations is basically the same for point, segment
or polygons maps, only the Polygon to Raster operation is shown here.
Creating georeferences
In this exercise the same polygon map will be rasterized three times, using three
different georeferences with different pixel sizes, to show you the effect of the pixel
size on the final result. The three georeferences will have pixel sizes of 10, 25 and
100 meters.

F

•

Double-click the NewGeoref item in the Operation-list.
The Create Georeference dialog box is opened.

•

Type for Georeference Name: Cocha10.

•

Select the Coordinate System: Cochabam.

•

Type for Pixel Size: 10.

•

Type for Description: Georeference with 10 meter pixel
size.

•

Click OK.

•

Create also the georeference Cocha25 with 25 meters pixel size and
Cocha100 with 100 meters pixel size.

Rasterization of a polygon map
The polygon to raster operation, creates a raster map from a polygon map. In this
exercise the polygon map Landuse will be rasterized.
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F

•

Double-click the PolRas item in the Operation-list.
The Rasterize Polygon Map dialog box is opened.

•

Select polygon map Landuse in the list box Polygon Map.

•

Type for Output Map: Land10.

•

Click the check box Show.

•

Type Raster map showing land use in the text box
Description.

•

Select the Georeference: Cocha10.

•

Click the OK button of the Rasterize Polygon Map dialog box. The
Display Options - Raster Map dialog box is opened.

•

Accept the defaults by clicking the OK button of this dialog box. The
raster map Land10 is displayed.

•

Repeat the procedure, and create the raster map Land25 with the
georeference Cocha25, and the raster map Land100 with the
georeference Cocha100.

•

Zoom in on the same part of the map in the three map windows.
Drag-and-drop polygon map Landuse to each of the three map
windows. Only display the boundary lines.

•

Compare the three maps and evaluate the effect of different pixel
sizes.

•

Close all map windows when finished.

Summary: Vector to raster conversion
−

Conversion from vector to raster format (rasterization) is often a necessary step
preceding data analysis.

−

Points, segments and polygons are represented by grid cells (pixels) in the
raster data structure.

−

In order to convert a map from vector into raster format, a mesh with predefined cell size is positioned over the map. The size of the grid cells is a
crucial aspect of the raster data structure.

−

Before starting the rasterization, a georeference should be created. A
georeference contains the minimum and maximum X and Y coordinates of the
raster map, the number of rows and columns and the pixel size.
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4.5 Raster data management
A raster map can be obtained either via rasterizing a vector map, as was explained
in the previous exercise, or from importing raster data, as was shown in exercise
4.1. A number of tools are available to adapt raster maps for the analysis. In order
to be able to use raster maps of the same area together, all maps should have the
same pixel size, and the same number of rows and columns. In this section a
number of tools for manipulating raster maps will be shown, such as the creation of
a sub map, combining two raster maps into one map, mirroring and rotating maps,
resampling maps, editing raster maps, and the conversion from raster to vector.
Creating a sub map of a raster map
The Sub Map operation allows you to specify a rectangular part of a raster map and
copy it into a new raster map. A raster map with any type of Domain can be used as
input. The output map uses the same domain as the input map. The operation
automatically creates a new georeference for the output map. This operation is very
useful for creating subscenes from an entire frame of a satellite image, only
covering the area of interest.
In this exercise, a selected window of a hillshading map of a part of south America
(Sashad) will be saved as a new raster map (Sashads). We also have a map
Bolmask, containing only the country of Bolivia. From this image the area that
has to be extracted can be found.

F

•

Open the map Bolmask, and find out the area that should be
extracted (expressed in first line, first column, nr of lines, nr. of
columns). Close the map window.

•

Double-click SubRas in the Operation - list.
The Sub Map of Raster Map dialog box is opened.

•

Select raster map Sashad in the list box Input Raster Map.

•

Type 300 in the text box First line.

•

Type 375 in the text box First column.

•

Type 670 in the text box Number of lines.

•

Type 650 in the text box Number of columns.

•

Type for Output Raster Map: Sashads.

•

Click the check box Show. Click OK.

•

Click OK in the Display Options - Raster Map dialog box.

•

Close the map window after seeing the result.

You can use the same method to extract the same area from the map Bolmask,
and then create a final map only showing the hillshading for the country of Bolivia.
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Glue two raster maps
The Glue Raster Maps operation merges two georeferenced raster maps. The input
maps should have a georeference and a domain which can be merged. The input
maps can have different georeferences, coordinate systems and pixel size. In the
case of different georeferences, the output map will use the georeference of the first
input map. If needed, the second input map will then first be resampled to the
georeference of the first input map. If the georeferences of the two input maps have
different coordinate systems, the coordinate system of the second input map will be
transformed into the coordinate system of the first input map. In the resampling
process, the size of the pixels in the second input map will be adjusted to the size of
the pixels in the first input map, if they are different.
If the maps have different domains, the possible combinations for merging of the
two input domains, are given in the table 4.3.
The output map is sized to allow both maps to fit in. In this way, you can glue two
adjacent or partly overlapping georeferenced raster maps, derived from different
sources. The output map uses a new georeference in which both input georeferences
fit. The map uses the coordinate system and pixel size of the first input map. It is,
therefore, important to make a careful choice of the input map.
In case two input maps overlap, users can define a pixel value that should be used
for overlapping parts. By default, the pixel values of the first input map are used.
Table 4.3: Possible combinations of domains of input maps and the resulting domain of the output
map
value

class

ID

color

picture

value

value
class
ID
color
picture
image

image
value

class
ID

value

color
color
color

color
picture

color
image

In this exercise two parts of a TM image, one covering the northern (Tmb1n) and
the other covering the southern part (Tmb1s) of the study area, are glued together.
Both maps have the image domain.

F
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•

Double-click GlueRas in the Operation - list.
The Glue Raster Maps dialog box is opened.

•

Select raster map Tmb1n in the list box 1st Map.

•

Select raster map Tmb1s in the list box 2nd Map.

•

Type Tmb1com in the text box Output Raster Map.

•

Click on the check box Show. Click OK. The map is created.
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•

Click OK in the Display Options - Raster Map dialog box. The
map is shown.

•

Close the map window when you have finished the exercise.

If you leave selected MAP 2 on top button, the values of the pixels defining the
overlap are taken from the second input map. Clear this check box if these values
should be taken from the first input map.
Mirror rotate
The MirrorRotate operation allows you to mirror a raster map in a horizontal,
vertical, or diagonal line, to transpose (switch) the map's rows and columns, or to
rotate a raster map 90°, 180°, 270° (clock-wise). There are no special requirements
for the input map. The output raster map uses the same domain as the input raster
map. The operation creates a new georeference for the output map which obtains
the same name as the output map. The new georeference depends on the
georeference of the input map. This operation may be needed if you get an input
raster map from another source, which is rotated or mirrored. For example, when
you use a scanned image and the image was not properly oriented on the scanner.
As an example there is a 3D view, which is upside down.

F

•

Display the map View3d. Close the map window again.

•

Double-click MirrorRotate in the Operation-list. The Mirror Rotate
Raster Map dialog box is opened.

•

Select raster map View3d in the list box Input Raster Map.

•

Select the option Mirror horizontal.

•

Type View3dok in the text box Output Raster Map.

•

Click the check box Show.

•

Click the OK button. The map View3dok is created.

•

Click OK in the Display Options - Raster Map dialog box. The
map is displayed now in the correct form.

•

Close the map window when you have finished the exercise.

Resampling
In many cases, the raster operations shown above will not be sufficient to get your
imported raster data in the correct form, to combine them with other maps. The
pixel size may be different from the other maps, or the map may lack coordinates.
To overcome these problems, the map should be resampled to another existing
raster map in your data base. Resampling will be explained in more detail in
chapter 6, dealing with image processing. Here it is important to note that many of
138

ILWIS User’s Guide

Spatial data management
the tools, originally designed for image processing, are equally valuable when
working with other types of raster maps.
Suppose that you have received a geological map from someone else. Suppose that
apart from the digital file you also received a table with a series of control points. If
these are missing you would have to find out control points yourself by comparing
the raster map with a topographic map, or with another digital map. This is shown
in chapter 6. Here it is assumed that 10 control points are known. The next thing to
do is to make a georeference for this map, using the control points listed in table
4.4.

F

•

From the File menu of the main window select Create and Create
Georeference.
The Create Georeference dialog box is opened.

•

Type for the Georeference Name: Geology.

•

Select the option Georef Tiepoints.

•

Select the Coordinate System: Cochabam.

•

Select the Background map: Geology.

•

Click OK.

•

Open the georeference Geology.
The Georeference Editor is opened, and the Display Options
dialog box is opened.
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•

Click OK.

•

From the Edit menu in the Georeference Editor select Add
Tiepoint.
The Add Tiepoint dialog box is opened.

•

Type the row, column, X and Y coordinates for the first point as
shown in table 4.4.

•

Repeat this for the other 9 tiepoints. The transformation should
display Affine, and the Sigma (the error) should be lower than 1.

•

Close the Georeference Editor. Raster map Geology is now
georeferenced.

•

Close the map window.
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Table 4.4: Tiepoint locations for the raster map geology
X
797955
804195
804915
797415
800078
802343
800835
796455
796050
802973

Y
8088615
8087085
8080185
8080335
8083830
8081985
8073450
8072865
8083628
8089080

Row
127
229
689
679
446
569
1138
1177
460
96

Column
165
581
629
129
306
457
357
65
38
499

Now that the raster map Geology is georeferenced, you can resample it to another
raster map, for example Landuse, which uses the georeference Cochabam.

F

!
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•

Double-click Resample in the Operation-list.
The Resample Raster Map dialog box is opened.

•

Select raster map Geology in the list box Input Raster Map.

•

Type for Output raster map: Geolout.

•

Select the Georeference: Cochabam.

•

Make sure the resampling method Nearest Neighbor is selected.

•

Click the check box Show.

•

Click OK.
The map Geolout is created.

•

Click OK in the Display Options - Raster Map dialog box. The
map which is now displayed has the same pixel size, rows and
columns as the raster map Landuse.

•

Close the map window when you have finished the exercise.

If you want to practice some more with resampling, you can generate control
points from the polygon map Citybl (city blocks of Cochabamba), and use
these to georeference the raster map airphoto (scanned airphoto of the center of
Cochabamba). Then rasterize the polygon map Citybl (with a pixel size of 5
meters) and resample the map airphoto.
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Editing raster maps
Maps often contain errors, which are introduced during digitizing, or which are in
the original imported data coming from other packages. Maps also need to be
updated, when changes have occurred in an area, for example when the land use
has changed. In those situations you will need to edit maps. When you use the Pixel
Editor you can change the value, IDs or class name of pixels in a raster map. In the
Pixel Editor, only the mouse pointer can be used, not the digitizer cursor.
Editors can only be used to edit source maps. Dependent maps (e.g. the raster map
created by rasterizing a polygon map), or maps which are defined in their
properties form as read only, can not be edited. Conceptually, it would not be a
good idea to edit a dependent map, since such a map is derived from source maps,
which are not changed in that case. To edit a dependent map, you should either edit
the source map(s) or remove the dependency. To edit a read-only map, you should
edit the properties and deselect the check box Read-only.
Editing raster maps using the pixel editor, is only useful if you want to make
relatively small changes to a raster map. Since you can only edit pixel by pixel
(including the possibility to select multiple pixels, and rectangular groups of
pixels), changing irregular shapes in a raster map is rather time consuming. In that
case it would be better to convert the raster map to vector (as will be explained in
the next exercise) and do the editing in the segment editor. Another option would
be to digitize the areas that should be changed as lines or polygons, rasterize these
vector maps and use them in a map calculation statement to mask away the wrong
areas in the raster map. In this exercise you will edit a raster map (called Wrong)
with a class domain.

F

•

Display the raster map Wrong. As you can see there is a part that
needs to be edited: the word Edit.

•

From the Edit menu in the map window, select Edit Layer, and 1.
map Wrong.
The Pixel Editor is opened. It asks you to zoom in on the raster map.
When you have zoomed in sufficiently, the pixel values of the
individual pixels are displayed.
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•

Click the OK button in the box asking you to zoom in.

•

Zoom in on the word Edit the raster map.

•

Select with the left mouse button a part of the letter E which is
surrounded by green pixels and drag the box to the lower right part of
the green area.

•

Press the right mouse button and select Edit from the Contextsensitive menu. The Edit dialog box is opened.

•

Type for New Value: 4. Click OK.
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In the pixel editor, you can select one or more pixels by clicking them or dragging a
box around them, in order to change their class name, ID, or value. You can add
pixels to a selection, clear a part of a selection or toggle between select and deselect
pixels. To add pixels to a selection: Press and hold the CTRL key and click the
other pixels you want to select. To clear a part of a selection: Press and hold the
CTLR+SHIFT keys, then click previously selected pixels or drag a box around
them. To toggle between select and deselect pixels: Press and hold the SHIFT key,
then click pixels or drag a box around pixels (selected pixels are deselected and
non-selected pixels are selected).

F

•

Practice with these various options. Edit the map so that the word
EDIT is replaced by the pixel values of the areas surrounding it.

•

Exit the Polygon Editor when you have finished the exercise.

•

Close the map window.

Raster to Vector conversion
Sometimes it is also necessary to convert raster maps back to vector maps. This can
be the case, if you obtain a thematic raster map by importing a digital file from
other sources. If you want to edit the map extensively, it is better not to do that with
the pixel editor. It is best to convert the raster map to polygons first, then extract
segments and create labels, and do the editing in the segment editor, after which
you polygonize and rasterize the map again. It may also be useful to convert raster
maps back to vector maps if you want to use them for high quality map production.
To convert raster data to vector data format, a 3 X 3 matrix moves over the input
map and assigns a code (class name, ID or value) to the center pixel of the matrix
in the output map, which depends on the class name, ID or value of the center pixel
and its 4 or 8 neighbors. See chapter 9 for more information about 4 or 8connectivity. Undefined pixels will not be vectorized. The result of the conversion
depends on the homogeneity of the raster map and the pixel size compared to the
size of the mapping units. The program is provided with a smoothing facility, to
remove the sharp corners formed by the boundaries between mapping units of the
raster map. Automatic tunneling (see chapter 3) is performed on the coordinates of
the vector data to delete the redundant ones. The input map is a raster map with
domain class, ID, value, or group.
In this exercise the raster map Slopecl is converted to a polygon map.

F
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•

Double-click RasPol in the Operation-list.

•

The Polygons of Raster Map dialog box is opened.

•

Select raster map Slopecl in the list box Raster Map.
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•

Type Slopecl in the text box Output Polygon Map.

•

Click the check box Show.

•

Type Polygon map slope classes in the text box
Description.

•

Click OK.
The calculation will take some time. After that the Display Options
- Polygon Map is opened.

•

Accept the defaults by clicking the OK button.
The polygon map is shown.

•

Close the map window when you have finished the exercise.

Now you will see the effect of converting a raster map to segments. When you
convert from raster to segments, only the boundary lines between mapping units are
stored, but in such a way that it is still possible to find out what the mapping units
on both sides of the line are.
The output map resulting from the raster to segment conversion, uses an internal
class domain. In the next section you will learn more about internal domains. The
class name of a segment between two areas, is the combination of names (class
name, ID or value), of the areas on both sides of the segment. For example, the
class name of the segment between an area with class name a and an area with
class name b is a|b (figure 4.5).
The input raster map

a
a
a
a
a
a

a
a
a
a
a
a

b
a
a
a
a
b

b
b
b
a
b
b

b
b
b
b
b
b

The output segment map

b
b
b
b
b
b

a|b

Figure 4.5: Conversion of a raster map to a segment map (see the text for explanation)

F
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Double-click RasSeg in the Operation-list.
The Segments from Raster Map dialog box is opened.

•

Select raster map Slopecl in the list box Raster Map.

•

Type Slopeseg in the text box Output Segment Map.

•

Click the check box Show.

•

Type Segment map slope class in the text box Description.
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•

Clear the Single Names check box. Click the OK button.
The Display Options - Segment Map is opened.

•

Select the check box Info and click OK.

•

Find out the class names of the segments.

•

Close the map window when you have finished the exercise.

Summary: Raster data management
The following tools can be used for raster data management:
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−

Copying a rectangular part of a raster map into a new raster map, using the
SubMap operation.

−

Merge two raster maps (GlueMaps operation).

−

Mirror, transpose or rotate a raster map (MirrorRotate operation).

−

Resampling a raster map to another georeference.

−

Editing a raster map using the Pixel Editor.

−

Converting a raster map to a polygon or a segment map.
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4.6 Domain conversion
In the previous exercise, especially during the exercise dealing with import, you
have seen that in ILWIS your map may have another domain than you would like.
Sometimes the domain of a map should be changed, e.g., converting a domain
Value to a domain Class. In this exercise the various methods for domain
conversion are treated.
A warning about changing domains
Apparently the easiest solution for changing the domain type would be to simply
change the domain in the Edit Properties dialog box of the map. This should be
done with care! This method is only recommended for converting between domains
of the same type (e.g. for converting a class domain Landuse1 with a class
domain Landuse). You should make sure, however, that the two domains have
the same ordering of the raw values. If the ordering is different, than the names in
the map will be mixed after changing the domain.
Changing domains of maps via the Edit Properties dialog box, is not
recommended for changing from one domain type to another (e.g. from domain
class to domain value). If you do that your file may become corrupted. For changing
domain types, follow the guidelines described below.
Conversion between an ID domain and a class domain
Class domains and identifier domains are not so very different. It is, therefore, easy
to convert from one type to the other. The conversion from a class domain to an
identifier domain can be done by clicking the button Convert to Classes in the
Properties dialog box of the domain. The conversion from an identifier domain to
a class domain can be done by clicking the button Convert to Identifiers in the
Properties dialog box of the domain.
Take for example the polygon map Landuse, containing the land use types in the
study area. This is a class map.

F
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•

Click the domain Landuse with the right mouse button and select
Properties.
The Properties dialog box is opened. As you can see the domain
contains 12 domain items.

•

Press the Convert to Identifiers button. The domain is converted to
an identifier domain.

•

Open the Properties dialog box of the domain Landuse again. Now
you can see that it reads: Domain Identifier Landuse.

•

Press the Convert to Classes button. The domain is converted back
to a class domain.
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The conversion from classes to identifiers is not very logical for the map Landuse,
since each land use class contains various polygons. An identifier domain is
generally useful if each domain item is linked to one map feature (point, segment,
polygon, or group of connected pixels in a raster map).
There is, however, a way to convert a class map to a Unique ID map, using the
Unique ID operation. This operation can be used to give a unique ID to all features
in a segment, polygon or point map. The results of the operation are a map and an
attribute table with the same name. The output map uses an ID. The output table
has the same ID domain as the output map and consists of one column, containing
the original class names. The information in the column consists of the classes, IDs
or values of the original map per ID in the output map.

F

•

Double-click UniqueID in the Operation-list.
The Unique ID dialog box is opened.

•

Select polygon map Landuse in the list box Input Map.

•

Type Landid in the text box Output Map.

•

Type Landid in the text box New Domain.

•

Select the check box Show. Click OK. The map Landid is made
and the Display Options dialog box is opened. Click OK.

•

Click the polygons in the map window to view the IDs.

•

Open the table Landid to view the original class name of the
polygons and the assigned ID.

•

Close the map window and the table when you have finished the
exercise.

The UniqueID operation can only be performed on vector maps. The equivalent
operation for raster maps is called Areanumbering, and will be treated in chapter
9.
Converting a class or ID domain to a value domain
The conversion from a class or an identifier domain to a value domain, can best be
done by creating another map through renumbering the original class or ID map
with a column from the attribute table. Conversion from a class map to a value map
is mostly forming part of an analysis, in which the original class or ID map is
renumbered with attribute information from a table linked to a map.
Take for example the map Citybl, which is a map using an identifier domain, in
which each building block of the city of Cochabamba has a separate code. Linked to
that map is an attribute table (Citybl) which contains, amongst others,
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information on the number of persons living in each cityblock (column
Population).

F

•

Open the polygon map Citybl and double-click some units to find
out the information from the attribute table Citybl.

In this case the conversion from identifier to value only makes sense when you
want to create for example a population map.

F

•

Close polygon map Citybl.

•

Click polygon map Citybl with the right mouse button and select
Vector Operations and Attribute Map.
The Attribute Map dialog box of Polygon Map is opened.

•

Select the Attribute: Population and type for Output Polygon
map: Populat. Click on Show and OK. The map Populat is
created and the Display Options dialog box opened. Click OK.

•

The map Populat is a value map. Check this by clicking some
units and looking at the Properties dialog box of the map Populat.

•

Close the map window and the dialog box.

The simple conversion of the map Citybl from identifier to value domain would
make no sense. If you do that the values have no logical meaning, and besides of
that the map can no longer be linked to an attribute table.
Converting a value domain to a class or ID domain
The conversion from a value or an image domain to a class domain may sometimes
be necessary. For example, when you have imported an ILWIS 1.4 map which only
had the .MPD and .MPI files, and the information of the class names in the .INF
files was lost. It is also possible that you imported a scanned thematic map as a
gray scale TIF file. When you want to convert from a value map to a class map, you
should know the names of the legend units that should be assigned to the different
values.
For the conversion from a value map to a class or ID map, there are two
possibilities:
−

When you have a value map that has values with a precision other then 1, you
should create a Group domain (in which the boundary values and the class
names are indicated) and use the Slicing operation as described in chapter 7.
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An example of this is the classification of a Digital Elevation Model into a
classified altitude map.
−

When you have a value map that has values with a precision of 1, which
actually display thematic information instead of measured data, the procedure
is as follows:

1. Create an ID domain with a sufficient number of items.
2. Change the domain from value to the ID domain in the Properties
dialog box of the map.
3. Edit the ID while keeping the map open.
This is illustrated with a map which was imported from ILWIS 1.4 in exercise 4.1.
The map Map3 only had a .MPD and a .MPI file when it was imported. It was
imported as with an image domain. It is, however, not an image but a class map
with information on land use types.

F

•

Open the raster map Map3. Click some pixels in the map.
As you can see the map displays numbers instead of class names.
Close the map window.

•

From the File menu in the main window, select Create and Create
Domain.
The Create Domain dialog box is opened.

•

Type for the Domain Name: Luse. Select the option Identifier, and
type for the number of items: 20. Click OK.
The Domain Editor is opened. No changes will be made now. Close
the Domain Editor.
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•

Open the Properties dialog box of the map Map3 and press the
button Edit Properties.
The Edit Properties dialog box is opened.

•

Select the domain Luse. Click OK. Note the change in the
Properties dialog box.

•

Click OK in the Properties dialog box.

•

Open the map Map3 and the domain Luse. Click a unit to find out
its ID. Change the name of this ID to the class name, according to
table 4.5.

•

Change all the domain items and replace them by the land use type,
according to table 4.5. Delete the domain items that are not used.
Close the domain editor.
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•

Open the Properties dialog box of the domain Luse and press the
Convert to Classes button.
Now a representation is also created with the same name (Luse).
Close the Properties dialog box.

•

Now you can edit the representation and the conversion from value to
classes is ready. Close the map window.

Table 4.5: Relation ID and Class names
ID
nr 1
nr 2
nr 3
nr 4
nr 5
nr 6
nr 7
nr 8
nr 9
nr 10
nr 11
nr 12

Class name
Agriculture
Agriculture (irrigated)
Airport
Bare rock
Bare soils
Forest
Grassland
Lake
Riverbed
Shrubs
Urban centre
Urban periphery

Converting a picture domain to a class domain
The conversion from a picture domain to a class domain, can be done by clicking
the button Convert to Classes in the Properties dialog box of the domain. If you
want to convert a picture domain to an identifier domain, you first convert it to
classes and then press the button Convert to Identifiers in the Properties dialog box
of the domain.
This type of conversion is also quite common, after importing a windows bitmap
.BMP or .TIF file, or after importing an ILWIS 1.4 raster map that had a .MPD,
.MPI, and .COL file, but no .INF. Similarly for the conversion from value to class,
you should know which pixel values represent which classes.
This is also illustrated with a map which was imported from ILWIS 1.4 in exercise
4.1. The map Map2 had a .MPD, an .MPI, and a .COL file when it was imported.
The file containing the class names (.INF) was missing. It was imported with a
picture domain. It should be a class map, with information on land use types.

F
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•

Double-click raster map Map2. In the Display Options dialog box
select the check box Info and click OK. Click some pixels in the
map. As you can see the map displays a combination of red, green
and blue instead of class names. Close the map window.

•

Open the Properties dialog box of the domain Map2 and press the
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button Convert to Classes.
•

Open the map Map2 and the domain Map2. Click a unit to find out
its class name.

•

Change all the domain items and replace them by the land use type
according to table 4.5. Deleting the domain items that are not used is
not necessary (there are in total 256 classes). Close the domain
editor.

•

Now you can edit the representation and the conversion from picture
to classes is ready. Close the map window.

Converting a picture domain to a value domain
The conversion from a map with a picture domain to a value domain may
sometimes be necessary. For example, when you have imported from ILWIS 1.4 a
byte map, which was actually an image or a value map (.MPD and .MPI files
without a .INF file), but which also had a color lookup table (.COL file). In that
case the default output domain during the conversion is the picture domain. The
import of TIF color files or BMP files also results in a picture domain for the output
map, while in fact it should be value (in the case of a slope map for example), or
image (in the case of a satellite image). So the conversion from picture to value, or
to image, may happen quite often. Since a picture domain is used for byte maps, the
conversion can simply be done by changing the domain type in the Properties
dialog box.
This can be demonstrated with the hillshading map of Bolivia (Sashad), which
was imported in exercise 4.1 from Windows bitmap .BMP format. This map has a
picture domain. It will be converted to an image domain.

F
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•

Open raster map Sashad. Check that the map has a Picture
domain. Close the map window.

•

Click raster map Sashad with the right mouse button and select
Properties.
The Properties dialog box is opened.

•

Press the Edit Properties button. The Edit Properties dialog box is
opened.

•

Change the Domain to Image. Click OK in the Properties dialog
box.

•

Click OK.

•

Open raster map Sashad again. From the Display Options dialog
box you can see that the map has domain image. Check this by
clicking some units and looking at the Properties dialog box.

•

Close the map window and the dialog box.
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Converting a color domain to a value domain
Finally, there is a possibility that you have imported a 24 bits/pixel Windows
bitmap. This is converted in ILWIS to the color domain. The colors of a map with a
color domain, can only be seen correctly when your screen uses a 24 bits/pixel
display (millions of colors). You can convert maps with a color domain easily to an
image domain, with the Color Separation operation (which will be explained in
chapter 13).

Summary: Domain conversion
You should be careful when changing the domain of a map. If you do not follow the
guidelines described in this section, the file may be corrupted.
The following domain conversions are possible in ILWIS:
−

Conversions between class and ID maps, is easily done by pressing the Convert
to Identifiers button or the Convert to Classes button, in the Properties dialog
box of the domain.

−

Conversion from class or ID to value, is done by renumbering the class/ID map
with a value column from an attribute table.

−

Conversion from a value domain to a class/ID domain, can be done either by
using the Slicing operation (when the value map has a precision other than 1),
or by creating an ID domain, and replacing this in the Properties dialog box of
the map (when the value map has a precision of 1).

−

Conversion from a picture domain to a class domain can be done, by pressing
the Convert to Classes button in the Properties dialog box of the domain.
Conversion to ID domain can then also be done (see above).

−

Conversion from a picture domain to a value domain can be done, by changing
the domain in the Properties dialog box of the map.

−

Conversion from a color domain to an image domain can be done with the
Color Separation operation.
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